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Le principe fondamental d'Altium Designer est une approche unifiée en matière de conception des 
circuits imprimés. En mettant en œuvre cette approche, vous constaterez que notre outil diffère 
de la plupart des autres solutions plus classiques actuellement disponibles. En effet, notre flux 
de travail permet de réunir un certain nombre d'éléments distincts et interconnectés nécessaires 
pour aboutir à une conception efficace de vos circuits imprimés.

Si vous utilisez actuellement OrCAD® ou Allegro®, vous êtes probablement habitué à avoir de 
multiples outils et interfaces pour chaque étape de votre processus de conception. Et tandis que 
chaque outil excelle dans sa propre tâche spécialisée, vous devez au bout du compte gérer et mé-
moriser plusieurs interfaces, flux de travail et méthodologies. Depuis que nous sommes présents 
dans le domaine de la conception de circuits imprimés, nous nous sommes posés la question 
suivante : cette approche est-elle vraiment efficace ?

Lorsque nous avons créé Altium Designer, nous voulions créer une expérience qui confère aux in-
génieurs un contrôle total sur leur efficacité et leurs flux de production tout au long du processus 
de conception. Pour atteindre cet objectif, il nous a fallu entrer dans le vif du sujet et nous nous 
sommes demandé ce que signifiait au quotidien une expérience complète de conception de cir-
cuits imprimés pour l'ingénieur ? Dans le cadre de notre approche, nous avons réuni les processus 
suivants dans une seule interface :

•	 Capture de schémas
•	 Routage de carte
•	 Gestion des données de conception
•	 Règles et contraintes
•	 Nomenclature
•	 Intégration de la chaîne d'approvisionnement
•	 Gestion des modifications techniques
•	 Collaboration CAO mécanique
•	 Documentation de la fabrication

Comme tous ces éléments sont désormais intégrés dans une seule interface générale, pour bas-
culer entre les tâches, il suffit simplement de sélectionner le fichier approprié dans votre espace 
de travail de conception. L'interface gère ensuite tout le reste et vous fournit les outils dont vous 
avez besoin pour accomplir la tâche en question.

Notre approche unifiée en matière de conception de circuits imprimés n'a cessé de se développer 
et d'évoluer au cours des 30 dernières années de recherche et de développement. Nous avons 
constaté qu'elle constituait tout simplement la façon la plus efficace de concevoir des composants 
électroniques. Cette philosophie ne s'étend pas seulement à l'ingénieur individuel, mais aussi à 
l'ensemble de l'équipe de conception. En effet, plusieurs ingénieurs peuvent travailler sur des as-
pects différents d'un même projet au sein de la même interface. Il en résulte un gain de temps non 
négligeable lors de la conversion des données entre les environnements de conception. 

Nous espérons que vous apprécierez votre voyage dans le monde d'Altium Designer.

La philosophie Altium Designer
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Mike Moore, Ingénieur des applications sur site et membre 
de l'équipe Altium Designer
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Installation de l'assistant d'importation
Avant de commencer à préparer un fichier OrCAD®, la première étape consiste à vous assurer que 
les deux outils d'importation spécifiques à OrCAD® et Allegro® ont bien été installés. À cette fin, 
vous pouvez effectuer les étapes suivantes directement dans Altium Designer :

1.	Ouvrez Altium Designer
2.	Sélectionnez File » Import Wizard
3.	Sélectionnez Next  (Suivant) sur l'écran de bienvenue

L'écran suivant, « Select Type of Files to Import » (Sélectionner le type de fichiers à importer), 
énumère les outils d'importation installés.

Préparation de vos fichiers OrCAD® et Allegro® 

Lors du processus d'installation d'Altium Designer, vous pouvez choisir les outils d'importation et 
d'exportation à installer. Les utilitaires de conversion OrCAD® ou Allegro® ne font pas partie de 
l'installation par défaut et doivent donc être sélectionnés manuellement.

Si les options « Allegro Design Files » (fichiers de conception Allegro) ou « OrCAD Design and Libra-
ries Files » (Fichiers OrCAD de conception et de bibliothèque) ne figurent pas dans la liste comme 
indiqué ci-dessus, procédez comme suit pour les ajouter :

1.	Sélectionnez Get More Importers (Obtenir d'autres outils d'importation) dans le coin in-
férieur gauche de la fenêtre de dialogue de l'assistant d'importation pour ouvrir l'onglet 
Extensions & Updates (Extensions et mises à jour) dans l'environnement Altium Designer.

Sélection des types de fichier dans l'assistant d'importation d'Altium Designer
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3.	Cochez les cases en regard des options Allegro® et OrCAD® pour activer les extensions.
4.	Faites défiler à nouveau vers le haut et sélectionnez Apply  (Appliquer). Ensuite, vous devrez 

redémarrer Altium Designer pour terminer l'installation.
5.	Sélectionnez File » Import Wizard (Fichier » Assistant d'importation) et confirmez que les 

outils d'importation Allegro® et OrCAD® ont bien été ajoutés.

Une fois l'outil d'importation ajouté dans Altium Designer, vous pouvez commencer à préparer 
vos fichiers OrCAD® et Allegro® pour le processus d'importation.

Préparation de vos fichiers OrCAD® et Allegro® 

2.	Sélectionnez Configure (Configurer) sur la droite et faites défiler jusqu'à la section Impor-
ters\Exporters (Outils d'importation\Outils d'exportation).

Section Altium Designer Extensions & Updates

Activation des outils d'importation Allegro® et OrCAD® dans la section
Altium Designer Extensions & Updates
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Préparation de vos fichiers OrCAD® et Allegro® 

Versions et formats de fichiers OrCAD® pris en charge
L'Assistant d'importation OrCAD® pour Altium Designer prend en charge une variété de versions 
de fichiers, répertoriés ci-dessous. Nous vous recommandons d'utiliser des versions de fichier 
OrCAD® récentes.

•	 OrCAD® Capture : versions 16.x, 15.x, 10.x et 9.x
•	 OrCAD® PCB Editor (Allegro) : versions 16.x, 15.x et 14.x
•	 OrCAD® Component Information System (CIS)

REMARQUE : OrCAD® Layout (version 9.x) est également pris en charge par l'outil OrCAD d'impor-
tation de conception et de fichiers de bibliothèque®. Cependant, ce produit a été retiré en 2009. 
Nous n'en parlerons donc pas plus en détail.

Veuillez garder les informations suivantes à l'esprit lorsque vous utilisez la fonction Import Wizard :

•	 L'assistant d'importation convertit les schémas, les circuits imprimés et les fichiers de la 
bibliothèque de configuration CIS.

•	 OrCAD® Layout n'est plus disponible et a été remplacé par OrCAD® PCB Editor (Allegro®)

•	 Les fichiers binaires sources OrCAD® PCB Editor (par ex. ‚ les fichiers de carte *.brd) sont 
les mêmes que ceux utilisés 
dans Allegro®.

•	 L'Assistant d'importation gère les fichiers de conception OrCAD® PCB Editor/Allegro® (.brd) et 
les fichiers extraits ASCII OrCAD® PCB Editor/Allegro (.alg). Si vous avez in-
stallé OrCAD® PCB Editor/Allegro versions 15.2 ou 16.x sur votre ordinateur, 
vous pouvez directement convertir des fichiers de conception OrCAD® PCB Edi-
tor/Allegro (.brd) en fichiers de circuit imprimé Altium Designer PCB (.PcbDoc). 
Remarque : une version d'évaluation gratuite d'OrCAD® ou une copie d'OrCAD® PCB Desi-
gner Lite est amplement suffisante.

•	 La_partie_CIS_d'OrCAD®_Capture_CIS_ne_sera_pas_abordée_ici._Cependant, si vous vou-
lez convertir des fichiers OrCAD® Capture CIS en fichiers Altium Designer, vous trouverez 
toutes les instructions nécessaires sur la page: 
Conversion de fichiers CIS en fichiers Altium Designer (en anglais)
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Conversion de vos schémas

Importation de fichiers de schéma OrCAD® Capture (.DSN) dans Altium Designer

1.	Sélectionnez File (Fichier, en haut à gauche) » Import Wizard (Assistant d'importation).

6

2.	La boîte de dialogue de l'assistant d'importation s'affiche. Cliquez sur Next (Suivant) pour 
continuer.
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Conversion de vos schémas
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3.	Sélectionnez OrCAD® Designs and Libraries Files (Conceptions et fivhiers de bibliothèque) 
dans l'écran Select Types of Files (Sélectionner les types de fichiers). Puis, cliquez sur 
« Next » (Suivant).

4.	Cliquez sur « Add» (Ajouter) pour accéder à l'emplacement du fichier .DSN à importer. 
Le fichier apparaîtra comme indiqué dans la figure ci-dessous. Puis, cliquez sur « Next» 
(Suivant) pour continuer.
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5.	Pour ajouter des bibliothèques OLB OrCAD®, cliquez sur le bouton « Add » (Ajouter) pour 
sélectionner le ou les fichiers de bibliothèque à importer. Puis, cliquez sur « Next » (Sui-
vant) pour continuer.

6.	La page Reporting Options permet d'activer ou de désactiver les paramètres de journalisa-
tion pour les erreurs, les avertissements et les événements. Cliquez sur « Next» (Suivant) 
pour continuer.



MIGRATION VERS ALTIUM DESIGNER DEPUIS ORCAD

www.altium.com

Conversion de vos schémas

9

7.	Comme indiqué ci-dessous, nous vous recommandons de garder cette case cochée, de 
sorte que les rectangles soient correctement importés. Cliquez sur « Next » (Suivant) pour 
continuer.

8.	Utilisez les options Title Block (bloc de titre) et Pin-to-Pin Spacing (espacement entre 
broches) suivantes pour contrôler le mode d'importation des pages de schéma OrCAD® 
Cliquez sur « Next » (Suivant) pour continuer.
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9.	La boîte de dialogue Schematic Parameter and Net Connectivity Options (paramètre 
de schéma et options de connectivité entre nœuds) contrôle la façon dont les paramètres 
et les jonctions sont traités. Les valeurs par défaut sont affichées ci-dessous. Cliquez sur 
« Next » (Suivant) pour continuer. 

 
Auto-position parameters (paramètres d'auto-positionnement) : Cette option permet 
d'ignorer les emplacements des paramètres des composants importés et utilisera les 
réglages de justification du paramètre pour le positionnement. 
 
Désactivez l'option « Mark Manual Parameters » (marquer les paramètres manu-
els) : Si cette option est activée, les emplacements de paramètre des composants positi-
onnés sont marqués d'un indicateur visuel. Cette préférence peut être réactivée dans Alti-
um Designer en accédant à  DXP » Preferences » Schematic » Graphical Editing » Mark 
Manual Parameters (DXP » Préférences » Schéma » Modification graphique » Marquer les 
paramètres manuels). 
 
Import OrCAD Junctions (importer les jonctions OrCAD) : Lorsque cette option est défi-
nie sur la valeur All (tous), une jonction manuelle sera ajoutée à la fois aux jonctions à 3 
et 4 contacts. Lorsqu'elle est définie sur Only Cross Junctions (jonctions croisées unique-
ment), des jonctions manuelles seront uniquement ajoutées aux jonctions à 4 contacts. 
Toutes les autres jonctions seront générées automatiquement.
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10.	L'emplacement du projet par défaut pour le processus d'importation est illustré ci-des-
sous. Cliquez sur « Next » (Suivant) pour continuer.

11.	Le panneau Messages peut apparaître pour fournir une liste interactive des messages 
relatifs aux erreurs, aux avertissements et aux états générés lors de l'importation. Vous 
pouvez fermer cette boîte de dialogue en cliquant sur le symbole « x » dans le coin supéri-
eur droit de cette fenêtre.
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12.	Si le processus de conversion est réussi, cela signifie que l'exécution de l'assistant est 
terminée. Vous pouvez alors fermer l'assistant pour commencer à travailler sur vos con-
ceptions de schémas converties dans Altium Designer. Cliquez sur Finish (Terminer) pour 
terminer le processus d'importation.

Nettoyage des schémas
Vous devrez toujours effectuer un peu de nettoyage. Cela est généralement dû à des incompatibi-
lités entre les deux structures de données des systèmes CAO ou tout simplement à des différences 
dans la façon dont certaines fonctionnalités ou certains types d'objets ont été implémentés.

Dans cette section, nous allons aborder les parties communes du schéma converti qui doivent être 
examinées. Dans cet objectif et aux fins des sections suivantes relatives au nettoyage, nous assu-
mons que l'utilisateur possède au moins quelques connaissances de base sur Altium Designer et 
son utilisation. Pour apprendre les rudiments d'Altium Designer, veuillez consulter le document  
Démarrer avec Altium Designer.

Veuillez consulter le lien suivant pour en savoir plus sur la modification de plusieurs objets :
http://techdocs.altium.com/display/ADOH/Editing+Multiple+Objects
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Paramètres placés manuellement

Dans Altium Designer, les paramètres de composants visibles sont généralement positionnés au-
tomatiquement. Cela signifie que le système place le paramètre, y compris un désignateur de 
référence, dans un emplacement par défaut à côté du corps de symbole. Ceci s'avère utile lorsque 
des composants sont pivotés, car le système place les paramètres dans une position claire et li-
sible.

Dans un effort visant à reproduire avec précision le schéma source créé avec OrCAD® Capture, 
le réglage de positionnement automatique des paramètres est désactivé. Les désignateurs de ré-
férence et les paramètres sont ensuite placés aussi près de leur position d'origine que possible, et 
sont désormais considérés comme des paramètres manuels.

Une correspondance exacte n'est pas toujours possible en raison des différences de styles et tail-
les de texte définis par défaut. L'utilisateur peut apporter de légères modifications au paramètre 
de positionnement de texte.

Les paramètres qui sont positionnés manuellement sont marqués par un petit point comme il-
lustré ci-dessous:

Paramètres positionnés manuellement sur
un symbole de schéma
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Vous pouvez choisir de gérer ces paramètres manuels de l'une des trois façons suivantes :

1.	Laissez la conception en l'état.
2.	Laissez les paramètres en l'état tout en désactivant le point. Pour ce faire, accédez à Tools 

(Outils) » Schematic Preferences (Préférences du schéma), puis sélectionnez le groupe 
Graphical Editing (Modification graphique) et désactivez l'option « Mark Manual Para-
meters » (Marquer les paramètre manuels).

3.	Réactivez le réglage Autoposition (Auto-positionnement) dans la boîte de dialogue Parame-
ter Properties (Propriétés des paramètres) comme indiqué ci-dessous. Pour ce faire, vous 
devez utiliser l'option Find Similar Objects (Trouver des objets similaires) et le panneau SCH 
Inspector (Inspecteur de schéma).

Puisque le positionnement automatique des paramètres n'est effectué qu'au cours du positionne-
ment des composants ou du processus de rotation, l'effet du positionnement automatique ne 
sera pas visible tant que les composants n'auront pas été pivotés afin de les mettre en place.

Pour pivoter rapidement tous les composants afin de les mettre en place :

1.	Appuyez sur Ctrl+A pour sélectionner tout le contenu de la feuille du schéma
2.	Appuyez sur la barre d'espace pour tout faire pivoter à 90 degrés
3.	Appuyez sur Maj + barre d'espace pour pivoter tout le contenu sur sa position d'origine

Tous les paramètres et désignateurs vont maintenant être positionnés automatiquement.

Modification des propriétés des paramètres dans Altium Designer
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Différences de connectivité
Dans OrCAD®Capture, la connectivité des nœuds s'effectue à l'aide d'alias de nœud, de connec-
teurs hors feuille, de blocs et de ports hiérarchiques et de composants globaux. Les nœuds situés 
entre les pages de schéma se trouvant dans un seul dossier de schéma sont reliés par des connec-
teurs hors feuille, tandis que les blocs et les ports hiérarchiques relient les nœuds entre les dossiers 
de schéma. Des composants globaux sont utilisés pour connecter les nœuds d'alimentation ou de 
masse tout au long de la conception. Altium Designer utilise un ensemble similaire d'identifiants 
pour créer la connectivité des nœuds. Dans une feuille de schéma, vous pouvez utiliser des fils 
et des libellés de nœud. Entre des feuilles de schéma, les nœuds intégrés à une conception plate 
sont généralement connectés à l'aide des ports, mais des connecteurs hors feuille sont également 
disponibles. Les connecteurs hors feuille sont purement graphiques et ne possèdent aucune ca-
ractéristique électrique. C'est pour cette raison que nous vous recommandons d'utiliser des ports. 
Les nœuds d'une conception hiérarchique sont connectés à partir d'un port de la feuille inférieure 
à une entrée portant le même nom, dans le symbole de feuille qui représente la feuille inférieure. 
Les nœuds d'alimentation ou de masse sont connectés en utilisant les ports d'alimentation.

Les problèmes de connectivité peuvent se manifester après l'exécution du processus de compilati-
on (Project (Projet) » Compile PCB Project (Compiler le projet de circuit imprimé). Le panneau 
Messages signalera l'ensemble des erreurs et des avertissements qui indiquent des discordances 
entre les connectivités hiérarchiques et les connectivités des nœuds. Par exemple, une erreur Du-
plicate NetNames indique en général une mauvaise connectivité entre les feuilles.

Plutôt que de traiter chaque situation possible dans cette section, nous vous recommandons de 
vous familiariser avec la Connectivité et la conception multicouche dans les TechDocs.
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OrCAD® PCB Editor (Allegro) vers Altium Designer
La conversion de fichiers OrCAD® PCB Editor (Allegro) Design peut être gérée par l'outil Import Wi-
zard d'Altium Designer. Toutes les pages de cet assistant vous offrent toutes les commandes 
nécessaires pour configurer le processus de conversion selon vos besoins.

La fonction Import Wizard (Assistant d'importation) gère les fichiers Allegro PCB Design (*.brd) 
et Allegro ASCII Extract (*.alg). Si vous avez installé Allegro PCB Editor version 15.2 ou 16.x, vous 
pouvez directement convertir des fichiers Allegro PCB Design (*.brd) au format Altium Designer 
PCB (*.PcbDoc).

Les fichiers Allegro ASCII Extract (*.alg) peuvent être créés en exécutant un processus de traite-
ment par lot sur un ordinateur où est installé Allegro, comme nous le verrons plus tard dans la 
section intitulée « UTILISATION DE LA CONVERSION ASCII POUR IMPORTER SANS ALLEGRO. » Les 
fichiers ASCII peuvent ensuite être convertis au format Altium Designer PCB (*.PcbDoc) sur des 
postes sur lesquels Cadence Allegro PCB Editor n'est pas installé. L'avantage ici est que vous n'avez 
besoin que d'une seule copie sous licence de Cadence Allegro PCB Editor pour convertir toutes 
vos conceptions au format de fichier Allegro ASCII Extract (*.alg) avant de les distribuer à d'autres 
membres de l'équipe pour la conversion.

OrCAD® PCB Editor (Allegro) vers Altium Designer
L'assistant d'importation est disponible dans le menu File (Fichier) d'Altium Designer. Sélectionnez 
les fichiers de conception Allegro dans la liste de types de fichiers.

Dans Import Wizard, les fichiers sont convertis de la façon suivante :

•	 Les fichiers Allegro Binary PCB Design (*.brd) sont convertis en fichiers Altium Designer PCB 
(*.PcbDoc).

•	 Les fichiers Allegro ASCII Extract Files (*.alg) sont convertis en fichiers Altium Designer PCB 
(*.PcbDoc).

Vous pouvez aussi faire glisser vos fichiers Allegro Design dans le panneau Projects qui lancera 
automatiquement l'assistant en mode Allegro Import.

Conversion de vos circuits imprimés



MIGRATION VERS ALTIUM DESIGNER DEPUIS ORCAD

www.altium.com

Conversion de vos circuits imprimés

17

1. Sélectionnez File » Import Wizard.

2. La boîte de dialogue suivante s'affiche. Cliquez sur « Next » (Suivant) pour continuer.
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3. Sélectionnez le type de fichier à importer (Allegro Design Files). Puis, cliquez sur « Next » 
(Suivant).

4. Cliquez sur le bouton « Add » pour accéder à l'emplacement du fichier .BRD (binaire) ou 
.ALG (ASCII) à importer. Le fichier apparaît comme indiqué dans la figure ci-dessous. Cliquez 
sur « Next » pour continuer.

Remarque: si vous tentez d'ajouter des fichiers de conception OrCAD® PCB Editor (Alle-
gro®) (*.BRD) dans l'outil Import Wizard, sans avoir installé au préalable une copie valide 
d'Allegro® sur votre ordinateur, un avertissement s'affichera.  Autre remarque : le message 
d'erreur risque de s'afficher même si vous avez installé OrCAD® PCB Editor.
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Conversion de vos circuits imprimés

Si la boîte de dialogue « Dxp » indiquée ci-dessous s'affiche, veuillez consulter la section inti-
tulée : « Utilisation de la conversion ASCII pour importer sans Allegro » ci-dessous. Dans cette 
section, nous allons vous montrer comment convertir vos fichiers de carte binaires au format 
ASCII afin de les importer dans Altium Designer.

6. Utilisez la page Reporting Options pour activer ou désactiver respectivement les paramèt-
res pour la journalisation des erreurs, des avertissements et des événements. Cliquez sur 
« Next » pour continuer.

Un journal au format de fichier ASCII (*.LOG) est généré pour chaque fichier Allegro® PCB 
converti. Ce journal est ensuite enregistré dans le sous-dossier \Imported de vos fichiers Al-
legro® d'origine. Vous pourrez ouvrir le journal après la conversion dans un éditeur de texte 
afin de l'examiner plus en détail.

7. Spécifiez les paramètres Polygon Connect et Plane Connect Options pour le processus 
d'importation du circuit imprimé. Activez l'option Import Auto-Generated Copper Pour 
Cutouts pour importer les éléments vides qui sont automatiquement générés dans Allegro® 
PCB Editor lorsque le fichier est converti.
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Conversion de vos circuits imprimés

REMARQUE : nous vous recommandons vivement de DÉCOCHER l'option Import Auto-Ge-
nerated Copper Pour Cutouts, si vous prévoyez de modifier la carte dans Altium Designer. 
Les options par défaut sont affichées ci-dessous avec le changement recommandé.

8. Toutes les couches de circuit imprimé Allegro® utilisées doivent être associées à une couche 
Altium Designer avant l'importation. Le mappage de couches est un mappage entre les noms 
des couches de circuit imprimé Allegro® et ceux des couches de circuit imprimé Altium Designer. 

Le mappage par défaut est assuré par l'outil Import Wizard pour créer le mappa-
ge des couches pour chaque circuit imprimé. Le mappage des couches peut être per-
sonnalisé pour chacune des conceptions à importer. Nous vous conseillons d'im-
porter plusieurs conceptions de circuit imprimé Allegro® et de mapper la même 
couche Allegro® à la même couche Altium Designer. Vous pouvez définir votre map-
page de couches une seule fois afin de l'utiliser pour tous les fichiers à importer. 

L'avantage de ce type de gestion des couches par lot est le gain de temps procuré lors de 
l'importation de plusieurs conceptions. L'inconvénient est que le mappage de couches par dé-
faut n'est pas toujours très efficace lorsqu'il s'agit de différencier les structures intégrées aux 
conceptions. Vous devrez donc probablement effectuer quelques modifications manuelles.
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Utilisez le bouton Menu dans l'outil  Import Wizard ou faites un clic droit sur la liste de map-
page des couches Allegro® et Altium Designer pour manipuler le mappage des couches des 
circuits imprimés Allegro® aux circuits imprimés Altium Designer. La sélection de l'une des 
couches Altium Designer affichera une liste déroulante qui permet à l'utilisateur de modifier 
la couche présélectionnée. Un clic droit sur la couche permet d'afficher une liste de couches 
semblables, mais permet également de sélectionner plusieurs couches puis de les modifier 
toutes en même temps. Ceci peut être utile si vous disposez d'un nombre important de cou-
ches Allegro® externes qui n'ont pas besoin d'être converties au format Altium Designer. Il 
vous suffit donc d'effectuer Ctrl+clic et/ou Maj+clic sur les couches indésirables. Puis, faites 
un clic droit sur l'une des couches sélectionnées, et choisissez Set Selection to.../Other 
Layers/No Layer. 

Vous trouverez également dans le menu contextuel l'élément Invert Selection, qui désélec-
tionne les éléments qui ont été sélectionnés dans la liste des couches et qui sélectionne 
ceux qui n'ont pas été sélectionnés auparavant. Cette méthode pratique constitue donc 
un moyen permettant de sélectionner rapidement les couches à mapper vers les couches 
Altium Designer.

Vous pouvez charger et enregistrer les fichiers de configuration du mappage des cou-
ches en utilisant respectivement les éléments de menu Load Layer Mapping et 
Save Layer Mapping. Ainsi, vous pourrez appliquer rapidement le mappage des couches 
Allegro® et Altium Designer aux conversions de design suivantes.
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9. L'emplacement du projet par défaut pour le processus d'importation est indiqué ci-dessous. 
Vous pouvez modifier l'emplacement si vous le souhaitez. Cliquez sur « Next » pour continuer. 

Chacun des fichiers de conception Allegro® importés se trouve dans un sous-répertoire spé-
cifié dans le champ Project Output Directory. Vous pouvez personnaliser davantage les pro-
jets de circuit imprimé en faisant glisser les noms de fichiers de conception Allegro® dans la 
liste PCB Projects.

10. La page Output PCB Projects est l'emplacement où chaque circuit imprimé Allegro® est 
converti en document Altium Designer (*.PcbDoc) dans un projet de conception. Un certain 
nombre de tâches intensives, telles que le chargement des données géométriques, la con-
version des nœuds et des composants, et la génération de vias et de polygones de cuivre, 
peuvent prolonger le processus. Vous pouvez surveiller la barre d'état au bas de l'espace de 
travail Altium Designer pour identifier l'opération en cours d'exécution à un moment particu-
lier.  Veuillez patienter jusqu'à ce que les boutons « Cancel », « Back », « Next » et « Finish » 
soient activés pour indiquer que le traitement est terminé.
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Utilisation de la conversion ASCII pour importer sans Allegro®

Un poste de travail Altium Designer qui ne dispose pas d'une version d'Allegro® sous licence peut 
toujours importer des fichiers Allegro® ASCII Extract (*.alg). La procédure suivante permet à un 
utilisateur ayant une licence Allegro® de convertir des fichiers binaires *.brd Allegro® vers le for-
mat *.alg Altium compatible. La conversion doit être exécutée sur l'ordinateur sur lequel la licence 
Allegro a été installée.

1.	Recherchez les fichiers suivants dans le dossier \System de l'ordinateur sur lequel vous 
avez installé Altium Designer : 
1.1 Allegro2Altium.bat 
1.2 AllegroExportViews.txt

2.	Copiez les deux fichiers dans le dossier contenant le fichier binaire *.brd d'Allegro® (versi-
on 15.2 ou 16.x).

3.	Ouvrez une invite de commande (DOS), accédez au dossier contenant ces fichiers, puis 
saisissez le nom de fichier suivant : Allegro2Altium your_file.brd

4.	Mettez votre nom de fichier entre guillemets, si celui-ci contient des espaces, par ex. : Alle-
gro2Altium "votre fichier.brd"

Poursuivez la lecture de ce document pour en savoir plus sur Altium Designer et vos conceptions 
de circuits imprimés.

11. Si le processus de conversion aboutit, cela signifie que l'exécution de l'assistant est ter-
minée. Vous pouvez alors fermer l'assistant et commencer à travailler sur votre conception 
de circuit imprimé convertie dans Altium Designer. Un nettoyage sera effectué sur le docu-
ment converti avant que vous puissiez le modifier. Cliquez sur « Finish » pour terminer le 
processus d'importation.
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Nettoyage d'une conception de circuit imprimé

Bien que l'utilitaire de conversion soit extrêmement efficace pour convertir avec précision les 
données d'un circuit imprimé, les incompatibilités entre les deux systèmes CAO risquent de vous 
obliger à effectuer d'autres modifications sur la conception importée.

Règles de conception
Allegro® et Altium Designer sont très différents lorsqu'il s'agit de configurer des règles. Allegro® 
utilise un gestionnaire de contraintes distinct et Altium utilise une méthodologie fondée sur une 
matrice. Les règles de conception d'Allegro® ne sont actuellement pas transférées dans Altium 
Designer. Ces règles devront être ajoutées manuellement dans Altium Designer.

Keepouts
Les objets keepout ont des capacités différentes dans Allegro® et Altium Designer. Dans ce der-
nier, un objet keepout peut être limité à une couche spécifique et peut avoir n'importe quelle for-
me physique, mais Altium Designer appliquera l'objet keepout à tous les composants électriques 
(via, piste, pad de composants, etc). En revanche, un objet keepout Allegro® peut être configuré 
pour exclure des types d'objets spécifiques (par ex., pour exclure les vias mais pas les pistes).

Quand un objet keepout Allegro® est configuré pour exclure plusieurs types d'objets, un seul objet 
keepout sera créé dans Altium Designer. Le type créé dépendra des options définies dans Allegro® 
et des options keepout activées dans l'outil Import Wizard.

Les incompatibilités keepout peuvent également s'étendre dans les empreintes de circuit imprimé. 
Les empreintes OrCAD® PCB Editor peuvent contenir les mêmes objets keepout configurables. Il 
est pratique courante pour les concepteurs d'inclure, par exemple, une zone keepout entre les 
pads d'un condensateur SMD, qui empêche le positionnement des vias entre les pads tout en 
laissant passer les pistes.

Dans l'empreinte Altium Designer, vous pouvez avoir une zone keepout entre les pads. En plus 
de la vérification des vias par le keepout, Altium Designer signalera également toutes les erreurs 
concernant un élément électrique (pistes, coulées de cuivre, etc.). Dans ce cas, l'objet keepout 
Allegro® peut être converti en un objet capable de produire des violations inattendues de la véri-
fication des règles de conception Design Rule Check. 

Si cette situation se produit, ces empreintes devront être modifiées dans la bibliothèque Altium 
pour supprimer l'objet keepout.

5.	Le fichier ASCII est créé dans le dossier. Copiez le fichier *.alg sur le poste de travail Altium 
Designer et effectuez l'importation à l'aide de l'outil Import Wizard.
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Isolation thermique des plans cuivrés (polygones)
Tous les systèmes de circuit imprimé traitent différemment la génération des plans cuivrés et 
l'isolation thermique. Puisque les connexions thermiques constituent, par définition, une règle de 
conception dans Allegro®, ceci ne nous concerne pas. Nous ne créons aucune règle de conception 
lors du processus d'importation dans Altium Designer. La seule option qui s'offre à vous au cours 
du processus d'importation est de définir un paramètre global dans la figure ci-dessous.

Altium Designer adopte une approche entièrement différente en matière d'isolation thermique, 
en gérant ces paramètres dans les règles de conception (règles de style de connexion des polygo-
nes). Dans la pratique, cette méthode permet une configuration thermique plus efficace, car tous 
les paramètres concernant les connexions thermiques se trouvent à un emplacement unique.

Configuration des règles de conception dans Altium Designer 
pour la connectivité des polygones

La règle de connexion SMT d'Altium Designer verra sa largeur de rayon thermique déterminée par le 
paramètre de largeur de rayon « SMT Thermals » spécifié dans la boîte de dialogue PADS® Options 
» Thermals. Si une autre configuration de connexion thermique spécifique est nécessaire, vous de-
vrez créer ces règles manuellement dans Altium Designer. Un exemple courant est une règle qui vise 
spécifiquement les vias pour une connectivité « flood over ». Pour ce faire, vous devez créer une règle 
et définir la portée sur « IsVia » non sur « All » et les contraintes (Constraints) sur « Direct Connect ». 
Pour en savoir plus sur la création de règles de conception, veuillez consulter la page relative à la 
Création de règles de conception dans les TechDocs.
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Bibliothèque de symboles de schémas OrCAD®

Pour traduire une bibliothèque de symboles de schéma OrCAD®, il vous suffit d'importer le 
fichier .OLB en procédant comme suit : 

1.	Sélectionnez le menu File en haut de l'écran, puis Import Wizard dans le menu File.

26
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2.	La boîte de dialogue suivante s'affiche. Cliquez sur « Next » pour continuer.

Conversion de vos bibliothèques de symboles de schéma
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3.	Sélectionnez le type de fichier à importer (OrCAD Designs and Libraries Files). Puis, 
cliquez sur « Next ».
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4.	Cliquez sur le bouton « Next » pour éviter d'ajouter des fichiers de conception OrCAD®. 
Vous pouvez convertir des fichiers de conception en même temps que des fichiers de bib-
liothèque (voir ci-dessus pour plus d'informations).

5.	Cliquez sur le bouton « Add » pour sélectionner les fichiers de bibliothèque OrCAD® à 
importer. Cliquez sur « Next » pour continuer.

6.	La figure ci-dessous illustre la fenêtre Schematic General Options (Options générales des 
schémas). Sélectionnez les options souhaitées dans celle-ci. Puis, cliquez sur « Next » (Sui-
vant) pour continuer.
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7.	Utilisez la page Reporting Options (Options de rapport) pour activer ou désactiver les 
paramètres pour la journalisation des erreurs, des avertissements et des événements. 
Cliquez sur « Next » (Suivant) pour continuer.

Conversion de vos bibliothèques de symboles de schéma

8.	Les paramètres par défaut de la bibliothèque de sortie sont présentés ci-dessous. Modi-
fiez ces options selon vos besoins. Cliquez sur « Next » (Suivant) pour continuer.
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9.	L'emplacement du projet par défaut pour le processus d'importation est illustré ci-des-
sous. Vous pouvez modifier cet emplacement si vous le souhaitez. Cliquez sur « Next » 
(Suivant) pour continuer.

10.	Si le processus de conversion est réussi, l'exécution de l'assistant est terminée. Vous 
pouvez alors fermer l'assistant pour commencer à travailler sur vos bibliothèques Capture 
converties dans Altium Designer. Cliquez sur « Finish » (Terminer) pour terminer le proces-
sus d'importation.
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Lorsque le processus est terminé, la bibliothèque de schémas convertie peut alors être ouverte à 
partir du panneau Projects (Projet).

Nettoyage de la bibliothèque de symboles de schéma
La plupart des symboles de schéma sont convertis avec précision, y compris les graphismes des 
symboles, les 
noms et numéros des broches, les paramètres et les pointeurs vers les empreintes. Cependant, 
vous devrez probablement apporter quelques modifications à la bibliothèque de symboles. 

Bibliothèque d'empreintes de circuit imprimé OrCAD PCB Editor (Allegro)®

Actuellement, notre outil de conversion ne prend pas en charge l'importation des bibliothèques 
d'empreintes de circuit imprimé Allegro®. Cependant, vous pouvez convertir des fichiers de carte, 
puis créer des bibliothèques à partir de ces fichiers dans Altium Designer. Vous pouvez également 
placer un certain nombre d'empreintes de circuit imprimé issues de vos bibliothèques Allegro sur 
une carte avant de les convertir à l'aide de l'outil de conversion. Ensuite, vous pouvez enregistrer la 
carte convertie en tant que bibliothèque dans Altium Designer.

Panneau Projects dans Altium Designer
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Gestion de projet
Bien que les conceptions de schémas et de circuits imprimés puissent être converties au cours 
de la même session de l'outil Import Wizard, ces conversions sont exécutées au cours de pro-
cessus distincts. Lorsque chaque conception a été convertie, les fichiers résultants sont placés 
dans des projets différents. Dans cet exemple, le schéma « Preview » et la conception de circuit 
imprimé « Previewpour » ont été traités en même temps par l'assistant d'importation, mais deux 
projets distincts et deux structures de dossiers projet distinctes ont été créés.

Utilisation de deux projets distincts importés dans Altium Designer

Si vous devez recréer la totalité du projet, vous devrez alors remanier certains fichiers. En géné-
ral, nous vous recommandons de placer tous les fichiers du projet dans le même dossier. Puis-
qu'il existe habituellement plusieurs documents de schéma et un seul document de circuit im-
primé, il est plus simple de copier ou de déplacer le fichier « .PcbDoc » dans le dossier du projet 
où se trouvent les fichiers « .SchDoc ».

À ce stade, nous n'avons pas besoin du projet de circuit imprimé importé (« previewpour.PrjPcb » 
dans cet exemple). Nous pouvons donc le fermer. Faites un clic droit sur le nom du projet dans le 
panneau (« previewpour.PrjPcb »), puis cliquez sur Close Project (Fermer le projet). À cet instant, 
« Preview.PrjPcb » devient le projet sur lequel nous allons travailler. Le fichier « .PcbDoc » doit 
maintenant être ajouté au projet. Accédez à Project » Add Existing to Project (Projet » Ajouter 
existant au project), ajoutez le fichier « .PcbDoc », puis enregistrez le projet.

Pour en savoir plus sur les projets, reportez-vous à la page Project Management (Gestion des 
projets) dans les TechDocs. 



MIGRATION VERS ALTIUM DESIGNER DEPUIS ORCAD

www.altium.com
33

Synchronisation de vos schémas et circuits imprimés

Synchronisation
Au lieu d'utiliser des désignateurs de référence pour synchroniser le schéma et le circuit im-
primé, Altium Designer utilise un identifiant (ID) unique. Il s'agit en quelque sorte d'un numéro 
de série pour chaque composant. Lors de la création d'une conception à partir de zéro dans Al-
tium Designer, chaque composant reçoit automatiquement un ID unique généré par le système 
dans l'éditeur de schémas. 

Lorsque la conception est transférée à l'éditeur de circuits imprimés, cet ID unique est transmis 
et ajouté à l'empreinte correspondante dans le document de circuit imprimé. Dans l'exemple 
ci-dessous, « U3 » a reçu l'ID unique « QPWPFFFF » qui est visible dans les éditeurs de schémas et 
de circuits imprimés.

Remarque : les ID supplémentaires affichés dans l'empreinte (« \UIRYJOSQ\AFOPTWNK\ ») provi-
ennent de la nature hiérarchique de cette conception particulière.

Configuration des propriétés des composants de schéma dans Altium Designer

Configuration des propriétés des composants dans
Altium Designer
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Lorsque les conceptions de circuit imprimé sont converties depuis OrCAD® PCB Editor (Allegro), 
des ID uniques ne sont pas attribués, car leur association à un schéma existant n'est pas garan-
tie. Heureusement, il existe un processus simple permettant de synchroniser les ID uniques du 
schéma converti avec le design de circuit imprimé converti. Pour l'exécuter, procédez comme 
suit :

Configuration de la liaison des composants entre un schéma
et un circuit imprimé

Les composants figurant dans les deux volets de gauche n'ont pas des ID uniques correspondants. 
L'objectif est de faire correspondre un composant de schéma avec un composant de circuit im-
primé. Vous pouvez y parvenir en sélectionnant manuellement une paire et en utilisant le bouton 
> pour ajouter le composant à la liste « Matched Components » (Composants correspondants) 
dans le volet de droite. 
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Il existe également une méthode automatisée qui se concentre à la fois sur les désignateurs de 
référence, les commentaires et les empreintes. Puisque le design a été à l'origine réalisé dans 
Cadence OrCAD®, il est raisonnable de supposer que les désignateurs de référence ont une corre-
spondance directe entre le schéma et le circuit imprimé. 
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1.	Ouvrez le fichier « .PcbDoc » et accédez à Project (Projet) » Component Links (Liaison 
des composants).

2.	Assurez-vous que la case Designator (Désignateur) est cochée (décochez les cases Com-
ment (Commentaire) et Footprint (Empreinte))

Association des composants de schéma et de circuit imprimé par leurs désignateurs
de référence dans Altium Designer

3.	Cliquez sur le bouton Add Pairs 
Matched By >> (Ajouter les paires 
mises en correspondance par >>). Cette 
opération associera automatiquement 
les composants du schéma et du circuit 
imprimé en fonction de leurs désigna-
teurs de référence.

4.	Sélectionnez Perform Update (Faire 
la mise à jour) pour synchroniser les 
paires d'ID uniques

5.	Cliquez sur « OK »

Confirmation de la liaison des composants

Cette opération permettra aux fonctions de vérification transversale et de demandes de modifi-
cation technique (ECO) de s'exécuter avec plus de précision.

Il convient de noter que, comme dans l'exemple ci-dessus, il ne peut y avoir une correspondance 
exacte dans la liste des désignateurs de référence. Cela peut être dû au fait que des composants 
de type mécanique ont été ajoutés à la carte, mais non au schéma, comme dans le « Shield » 
ci-dessus. Les trous de montage ajoutés comme composants constituent une autre disparité com-
mune. La situation inverse peut également être vraie, lorsqu'un composant est ajouté au schéma 
pour être inclus dans la nomenclature, alors qu'il n'a aucune représentation physique dans le 
circuit imprimé, par exemple un dissipateur thermique.



MIGRATION VERS ALTIUM DESIGNER DEPUIS ORCAD

www.altium.com
36

Synchronisation de vos schémas et circuits imprimés

Dans OrCAD®, ces situations sont traitées en définissant la propriété PSpiceOnly sur la valeur 
« True » (Vrai). Altium Designer dispose de plusieurs options pour définir le comportement ECO. 
Les propriétés des composants figurant dans les éditeurs de schémas et de circuits imprimés com-
prennent une liste des types de composants disponibles, comme indiqué ci-dessous. 

Configuration des options de propriété pour les demandes de changement technique (ECO) dans Altium Designer

Vous pouvez obtenir de plus amples informations sur les types de composants Altium Designer 
dans l'article sur les Concepts relatifs aux composants, modèles et bibliothèques. 

La définition du composant « Shield » (X1) sur la valeur Mechanical (Macanique) va le retirer de 
la boîte de dialogue Component Links (Liaisons des composants). Plus important encore, à cause 
de cela, le processus ECO ignorera X1 à titre de composant manquant. Sinon, X1 ne sera pas con-
sidéré lors d'une ECO car il n'a pas de schéma correspondant.

Demandes de modification technique (ECO)
À ce stade, l'exécution d'une ECO doit souligner les incohérences qui subsistent entre le schéma 
et le circuit imprimé. Dans le circuit imprimé, accédez à Design (Conception) » Import Changes 
from <nom de projet>(Importer les modifications de <nom de projet). Un ou deux messages 
peuvent s'afficher vous invitant à faire correspondre les noms de nœud manuellement. La meil-
leure chose à faire ici est de sélectionner No (Non) au départ, puis d'exécuter le reste du processus 
ECO pour renommer des nœuds ou effectuer d'autres modifications.

Confirmation de la correspondance manuelle
des noms de nœud
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Bien que de nombreux changements puissent être requis par le processus ECO, l'une des tâches 
les plus importantes consiste à renommer les noms de nœud attribués par le système. Comme 
indiqué dans la section Processus d'importation des schémas, OrCAD® Capture et Altium Designer 
créent de façon différente les noms de nœud attribués par le système. Il est généralement recom-
mandé de laisser le processus ECO convertir les noms OrCAD® Capture en noms Altium Designer, 
comme indiqué ci-dessous.

Noms de nœud attribués par le système dans Altium Designer

D'autres modifications pouvant être demandées par le processus ECO peuvent être contrôlées 
en sélectionnant Project (Projet) » Project Options (Options du projet). Si vous sélectionnez cette 
option, Altium Designer tentera par défaut de créer, supprimer et/ou synchroniser des classes de 
nœud, des classes de composant, des espaces, etc.

Configuration des options du projet pour une ECO dans Altium Designer
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Il appartient à l'utilisateur d'accepter ou non ces modifications. Les cases à cocher figurant dans la 
boîte de dialogue ECO permettent à l'utilisateur de désactiver temporairement une modification 
particulière. Les changements permanents apportés aux types de modifications qui ont été effec-
tuées lors d'une ECO peuvent être contrôlés à l'aide du menu Project (Projet) » Project Options 
(Options du projet), puis en configurant les options dans l'onglet ECO Generation (Génération 
d'ECO).

Il existe un certain nombre d'autres situations qui font que le processus ECO indiquent des dif-
férences entre le schéma et le circuit imprimé. Nous n'avons pas le temps de toutes les aborder 
ici, mais l'utilisateur doit être en mesure de déterminer les raisons de ces différences à l'aide des 
concepts que nous avons fournis. Pour en savoir plus, consultez le document  Recherche des dif-
férences et synchronisation des conceptions dans les TechDocs.
Votre but ultime est de recevoir un message après avoir effectué une mise à jour indiquant qu'au-
cune ECO ne sera générée ou qu'aucune différence n'a été détectée (selon la façon dont les op-
tions du projet sont définies).

Boîte de dialogue n'indiquant aucune différence
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Karlsruhe, Amersfoort, Kiev et Zoug, et en Asie-Pacifique à Shanghai, Tokyo et Sydney. Pour en savoir plus, rendez-vous sur le site www.altium.
com. Vous pouvez également suivre et communiquer avec Altium via Facebook, Twitter et YouTube.
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Vos prochaines étapes dans Altium Designer

Lorsque tous vos fichiers de conception auront été convertis à partir de Cadence OrCAD®, le 
temps sera venu de vous plonger plus profondément dans les méandres de l'environnement de 
conception unifiée d'Altium Designer. Vous trouverez ci-dessous des liens vers de la documenta-
tion, des tutoriels vidéos et des ressources de formation supplémentaire qui vous aideront à tirer 
le meilleur parti de votre logiciel Altium Designer.

Documentation d'assistance technique
•	 Mise en route d'Altium Designer  : Découvrez un ensemble complet de tutoriels qui vous 

aideront à créer votre premier schéma et routage de carte dans Altium Designer.
•	 L'environnement Altium Designer : Obtenez un aperçu complet de l'environnement de con-

ception unifiée dans Altium Designer.
•	 Gestion des bibliothèques et des composants : Apprenez à gérer facilement vos bibliothè-

ques de composants au sein de vos espaces de travail Altium Designer. 

Ceci n'est qu'un petit échantillon des vastes archives de la documentation Altium Designer dispo-
nible. D'autres documents sont disponibles sur le site techdocs.altium.com.

Vidéothèque
Notre suite complète de vidéos comprend entre autres plusieurs tutoriels et présentations de 
fonctionnalités pour vous aider à vous familiariser avec l'environnement Altium Designer. Accé-
dez à toutes les vidéos disponibles dans la Vidéothèque Altiumlive. 

Événements de formation en direct
Vous préférez une approche plus pragmatique pour vous former ? Inscrivez-vous à l'un de nos 
événements en direct, notamment des webinaires, des cours de formation et des séminaires. Dé-
couvrez tous les événements sur la Page des événements Altium. 

Besoin d'aide supplémentaire ?
Notre équipe d'assistance technique est à votre entière disposition pour répondre aux questions 
que vous pourriez avoir.  
Vous pouvez nous contacter directement via la page Contactez-nous.

Altium LLC, tous droits réservés. Eagle est une marque déposée de la société Autodesk, Inc.


